Contents at a Glance

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Introduction</td>
<td>xi</td>
</tr>
<tr>
<td>1</td>
<td>Getting Started</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>Fast Track</td>
<td>25</td>
</tr>
<tr>
<td>3</td>
<td>Working with SQL</td>
<td>43</td>
</tr>
<tr>
<td>4</td>
<td>Schema Browser</td>
<td>69</td>
</tr>
<tr>
<td>5</td>
<td>Working with Data</td>
<td>93</td>
</tr>
<tr>
<td>6</td>
<td>Working with PL/SQL</td>
<td>121</td>
</tr>
<tr>
<td>7</td>
<td>Miscellaneous Tools</td>
<td>157</td>
</tr>
<tr>
<td>8</td>
<td>Getting Started with Toad Automation</td>
<td>171</td>
</tr>
<tr>
<td>9</td>
<td>Database Administration</td>
<td>191</td>
</tr>
<tr>
<td>10</td>
<td>Toad as a SQL Tuning Tool</td>
<td>227</td>
</tr>
<tr>
<td></td>
<td>Index</td>
<td>251</td>
</tr>
</tbody>
</table>
# Table of Contents

## Introduction

- Who Should Read This Book ........................................................... xi
- Why This Book Is Unique ................................................................. xii
- How This Book Is Organized ............................................................ xii

### 1 Getting Started

- Introduction to Toad ....................................................................... 1
- Toad Release History ...................................................................... 2
- Toad Editions and Suites ................................................................. 3
- Prerequisites and Installation .......................................................... 5
- Running Toad the First Time ............................................................. 8
- Oracle Client Software .................................................................... 9
- Database Connections ................................................................... 10
- Introduction to Main Screens .......................................................... 16
- Basic Toad Customizations .............................................................. 18
- Common Newbie Questions ............................................................. 21
- Can Toad Do That? ....................................................................... 21
- Toad versus Database Security ...................................................... 22
- Sharing Toad Options Settings ....................................................... 22
- Help—Toad Running Slowly ............................................................. 22
- Summary ..................................................................................... 23

### 2 Fast Track

- Organizing Connections ................................................................. 25
- Toolbars and Menus ....................................................................... 30
- Keyboard Shortcut Keys .................................................................. 33
- Startup Windows/Screens ............................................................... 34
- Startup Files, Scripts, and Actions .................................................... 36
- Advanced Toad Customizations ..................................................... 37
- Sharing Toad Settings .................................................................... 40
- Summary ..................................................................................... 41

### 3 Working with SQL

- Editor Window ............................................................................... 43
- SQL Editor Output Area ................................................................. 48
- Object Describe ............................................................................. 51
- Toad Insights ................................................................................ 57
- Code Snippets ............................................................................... 58
- SQL Recall .................................................................................... 60
- Auto Replace ............................................................................... 63
## Contents

Query Builder ...................................................................................................... 64  
Summary ............................................................................................................. 68  

4 Schema Browser ........................................................................................69  
  Configuring the Schema Browser ................................................................. 69  
  Creating and Editing Objects ......................................................................... 76  
  Printing Data Using FastReport ................................................................. 79  
  Using the Reports Manager ......................................................................... 85  
  Summary ............................................................................................................. 91  

5 Working with Data .....................................................................................93  
  Reviewing Data Grid Options ......................................................................... 93  
    Filter/Sort the Table Data ........................................................................... 97  
    View/Edit Query ....................................................................................... 99  
    Show/Hide Columns .................................................................................. 100  
    Show Detail Dataset .................................................................................. 100  
    Calculate Selected Cells .......................................................................... 101  
    Export Dataset .......................................................................................... 102  
    Refresh Dataset ....................................................................................... 103  
    Cancel Query Execution or Fetch ............................................................ 104  
    Add/Delete Rows ..................................................................................... 104  
    Row Set Navigation Buttons ...................................................................... 105  
    Edit Row Set Control Buttons .................................................................. 105  
    Commit/Rollback ..................................................................................... 105  
    Bookmark Navigation .............................................................................. 105  
    Single Record Viewer ............................................................................. 105  
  Save Data in Various Formats ....................................................................... 106  
  Master Detail Browser .................................................................................... 111  
  ER Diagrammer ............................................................................................. 113  
  HTML Documentation Generator ................................................................ 115  
  Summary ........................................................................................................... 119  

6 Working with PL/SQL ...............................................................................121  
  Using the Editor ............................................................................................. 121  
  Using Code Templates .................................................................................... 127  
  Project Manager .......................................................................................... 132  
  Using Code Snippets ..................................................................................... 133  
  Code Shortcuts ............................................................................................. 135  
  Code Analysis ............................................................................................... 139  
  Using the Debugger ...................................................................................... 142  
    Basic Debugging ...................................................................................... 142  
    Advanced Debugging Techniques ............................................................ 148  
  Using the PL/SQL Profiler .......................................................................... 153  
  Summary ........................................................................................................... 156
# 7 Miscellaneous Tools

- Code Road Map: 157
- External Tools: 160
- Compare Files: 163
- TNS Editor: 164
- Script Manager: 165
- UNIX Monitor: 167
- Summary: 169

# 8 Getting Started with Toad Automation

- Command Line (Legacy): 172
- Automation Designer (Future): 180
- Summary: 190

# 9 Database Administration

- Health Check: 192
- Session Browser: 194
- Database Browser: 197
- Simple Export: 202
- Data Pump Export: 205
- Tablespace Management: 210
- Generate Database Script: 212
- Generate Schema Script: 214
- Compare Databases: 216
- Compare Schema: 218
- Analyze All Objects: 220
- Rebuild Multiple Objects: 223
- Summary: 224

# 10 Toad as a SQL Tuning Tool

- Toad and Explain Plans: 227
- SQL Statistics: 231
- Toad and SQL Trace: 233
  - Toad and TKPROF: 238
- Toad and Trace File Browser: 241
- Statspack Interface: 243
- AWR Browser: 245
- Toad and the PL/SQL Profiler: 246
- Toad and the SQL Optimizer: 248
- Summary: 249

# Index

251
About the Authors

Bert Scalzo is a Database Expert for HGST (a Western Digital company) and was formerly at Dell Software as a member of the Toad dev team for 15 years. He has worked with Oracle databases for more than two decades. Mr. Scalzo's work history includes time at both Oracle Education and Oracle Consulting. He holds several Oracle Masters certifications and has an extensive academic background—including a BS, MS, and PhD in Computer Science, an MBA, plus insurance industry designations. Mr. Scalzo is also an Oracle ACE.

Mr. Scalzo is an accomplished speaker and has presented at numerous Oracle conferences and user groups, including OOW, ODTUG, IOUG, OAUG, RMOUG, and many others.

He has written several books and numerous articles, papers, and blogs for the Oracle Technology Network (OTN), Oracle Magazine, Oracle Informant, PC Week (eWeek), Dell Power Solutions Magazine, The LINUX Journal, LINUX.com, Oracle FAQ, and Toad World.

http://bertscalzo.com/
Dan Hotka is a Training Specialist and an Oracle ACE Director who has more than 37 years in the computer industry, and more than 31 years of experience with Oracle products. His experience with the Oracle RDBMS dates back to the Oracle V4.0 days. Dan enjoys sharing his knowledge of the Oracle RDBMS. Dan is well published with 12 Oracle books and well over 200 published articles. He is frequently published in Oracle trade journals, regularly blogs, and speaks at Oracle conferences and user groups around the world.

Dan Hotka, Author/Instructor/Oracle ACE Director

www.DanHotka.com

Dan@DanHotka.com

DanHotka.Blogspot.com
Dedication

To my past and present miniature schnauzers Ziggy, Max, and Dexter—the three most wonderful four-legged kids that any parent could ever have. 😊

And to my wife Susan who’s always jealous of my many book dedications solely to the dogs…

Bert Scalzo, PhD

This book is dedicated to my grandson Riggs, without whom my family would not be the same. Here’s to the next generation!

Dan Hotka
We Want to Hear from You!

As the reader of this book, you are our most important critic and commentator. We value your opinion and want to know what we’re doing right, what we could do better, what areas you’d like to see us publish in, and any other words of wisdom you’re willing to pass our way.

We welcome your comments. You can email or write to let us know what you did or didn’t like about this book—as well as what we can do to make our books better.

Please note that we cannot help you with technical problems related to the topic of this book.

When you write, please be sure to include this book’s title and authors as well as your name and email address. We will carefully review your comments and share them with the authors and editors who worked on the book.

Email: errata@informit.com
Mail: Addison-Wesley/Prentice Hall Publishing
       ATTN: Reader Feedback
       330 Hudson Street
       7th Floor
       New York, New York, 10013

Reader Services

Visit our website and register this book at informit.com/register for convenient access to any updates, downloads, or errata that might be available for this book.
Introduction

A complete rewrite of the popular but dated *TOAD Handbook*, this book covers the very popular Toad for Oracle database management and development tool. It covers all the popular and key features of Toad, including many features that are new additions to Toad version 12.5. Moreover, this book offers numerous Toad tips and tricks, with ample expert advice and techniques—without focusing on any particular version of the Oracle database. Readers should be able to identify and readily adapt these “best practices” to their daily use of Toad.

**Who Should Read This Book**

This book should benefit all Toad users. It is ideal for a wide range of users, from those who are new to both Oracle and Toad, to very sophisticated or experienced users of Toad. Furthermore, this book attempts to address the specialized needs for three key database personas: database administrators, database application developers, and data/business analysts. In truth, Toad has so many features and offers so many benefits that no one book can realistically hope to fully cover them all. Thus, each chapter focuses on a particular functional or task-related area, covering it in depth with illustrations, tips, and techniques from Oracle and Toad experts.

This book is ideal for the following types of readers:

- The power user who wants easy access to data, help with SQL, and help with occasional coding assignments
- The user who wants to increase his or her productivity while using the Oracle RDBMS
The IT professional who is already familiar with Toad but needs help with its extended features

The developer who wants to do something specific but cannot remember how

Any Toad user who wants to learn how to take advantage of Toad's newly introduced features

Why This Book Is Unique

This book doesn't make assumptions about readers' prior Toad or Oracle administrative or development background, so it presents the full range of tips and techniques applicable to these tools. The main goal of this book is to illustrate the use of Toad and to serve as a handy reference for anyone using the Toad database tool. To this end, the book is liberally illustrated with working examples of all topics covered.

This book is intended to be a complete, single source of information, usage, tips, and techniques for the Toad tool. It focuses on the following topics:

- Toad installation and setup
- Development of PL/SQL and SQL statements and scripts in an easy-to-use and intuitive environment
- Tuning SQL and debugging PL/SQL
- Modeling any user's schema
- Routine and advanced DBA tasks
- Exporting of data into various formats
- Additional features such as ER diagrams, trace file analysis, tablespace management, object management, and the ability to add your own favorite editors and programs. This book includes a chapter on Toad as a SQL tuning tool, something Toad is very good at.

How This Book Is Organized

The chapters are organized as follows:

- Chapter 1, “Getting Started,” discusses the various versions and editions of Toad, and how it is packaged and sold. This chapter also details the installation and prerequisites for the computing environment that will run Toad. This chapter has a nice section on using Toad for the first time. The goal of this chapter is to jumpstart your learning process and make you productive with Toad ASAP.

- Chapter 2, “Fast Track,” is a fast track to customizing Toad at startup, navigating the menus, learning the key shortcuts, and customizing Toad for your personal preferences.
Chapter 3, “Working with SQL,” is all about the SQL Editor and working with SQL. This chapter shows a number of ways of creating SQL without doing much typing at all. This chapter shows how to set up your own personal code shortcuts, and illustrates how to use the SQL Recall (SQL history). This chapter concludes with how to create SQL via mouse operations using Query Builder.

Chapter 4, “Schema Browser,” covers saving, formatting, and reporting on data from about any data grid. The focus of this chapter is the Schema Browser and how to best configure it for your personal preferences, as well as how to work with the data in any data grid. This chapter concludes with a nice walkthrough of the FastReport feature built into Toad, a nice report writer.

Chapter 5, “Working with Data,” finishes the discussion on working with data grids, showing the data relationships and how to see them, generating SQL from the relationships, and more.

Chapter 6, “Working with PL/SQL,” is for the PL/SQL developer. Toad is rich with development features such as code templates, code snippets, and more. This chapter covers the PL/SQL Debugger and PL/SQL Profiler that are built into Toad.

Chapter 7, “Miscellaneous Tools,” illustrates the team-building features built into Toad.

Chapter 8, “Getting Started with Toad Automation,” explores using the Automation Designer or Toad’s own programming language to automate repetitive tasks.

Chapter 9, “Database Administration,” is for the DBAs using Toad. This chapter covers the database health check, how to monitor sessions and databases, tablespace maintenance, reporting, and more. Toad is an excellent Oracle administration tool.

Chapter 10, “Toad as a SQL Tuning Tool,” covers how to set up and use explain plans in Toad, illustrates useful hints, and reviews how to turn SQL Trace on/off via a number of mechanisms (for a session or for an individual SQL), and explores both the TKProf interface (the old and true character-mode trace analyzer) and Toad’s own trace file browser that allows you to quickly find the problem SQL.

We hope you enjoy using this book as much as we have enjoyed writing it.

Bert Scalzo
Dan Hotka
CHAPTER 3

Working with SQL

This chapter covers various aspects of the SQL Editor window, such as:

» Various modes to compile and execute code
» Using Toad history for past SQL
» Enhancing the interface to best fit your needs
» Using little-known items within the SQL Editor
» Code templates
» Building SQL without typing

Editor Window

Dell Software has a single editor now for all types of code, including SQL and PL/SQL. This editor is the main interface to Toad and enables the execution of SQL and SQL scripts, viewing data, saving data into various formats, and more. The SQL is saved in a history. Toad saves on keystrokes in a variety of ways; you can develop working SQL with a minimal amount of key entry. Toad also makes it easy for you to rerun recent work (using the Rerun menu button; see Figure 3.1).
FIGURE 3.1  Toad SQL Editor panel

The SQL Editor is the main interface to Toad. Simply type in a SQL statement and click the green triangle execute button \( \text{△} \). You can also press F9. This sends the SQL statement that the cursor is on (or the highlighted SQL) to the Oracle database. If the query is successful, then the data or success of the statement will be returned and displayed.

The Editor button \( \text{Inspector} \) makes opening additional Editor windows possible. This version of Toad enables you to open additional tabs in the Editor window. Simply right-click the tab just above the selected statement and select SQL or PL/SQL tab type. This opens another Editor window using the same database connection. Use the Editor button in the top-left row of buttons to open another Editor window, perhaps using a different connect string.

NOTE
Hover the mouse over any button to see a brief description of what it does.
TIP

You typically have three ways to do most any function in Toad:

▶ Menu item
▶ Keystroke
▶ Function key

Activating a menu item shows whether there is a button (it will appear) and any keystrokes that you can also use to activate the feature.

The top toolbar (refer to Figure 3.1), called the standard toolbar, provides access to various Toad browsers, features, commit/rollback, and initiating additional connections. Right-click on any of these top toolbars and you can select the ones you wish to have visible. By closing the ones you don’t use, Toad can perhaps have a larger Editor window. The window toolbar shows the active Toad windows. There are also toolbars for team coding, desktops, connection, jump search, and workspaces. You can change the color border per your needs. Dan uses red borders for SYS and SYSTEM accounts, and then a different color for each different Oracle database to which he connects. The next toolbar enables you to open code from the file system or from the database and also offers access to other features. You can right-click on these toolbars to show or hide the ones you don’t work with. The bottom toolbar has the Execute, Execute as Script, Clear, and Halt buttons. The Execute button will run all code in the Editor window. You can also just put the cursor on a SQL statement (if there are multiple SQL statements in the Editor window) and click this button. Toad will just execute the one SQL statement. Some people highlight the SQL they wish to execute. After execution, the Data Grid output tab will be populated. This technique works fine as well. The Execute as a script button runs the contents of the Editor window as if it were using a SQL*Plus character-mode interface. There is a separate Script Output tab for the result of this type of execution.

The Halt button stops the current SQL execution. It will un-gray as SQL is executing in Toad. This feature is also dependent upon Toad Options ➔ Oracle ➔ Transactions Run in Threads selected.

The Clear button (see Figure 3.2 at the cursor position) clears the contents of the SQL Editor window. One of the authors likes to simply open a new tab (right-click the tab, and select New Tab) and put each individual unit of work in its own tab. Use the + next to the existing open tab to open others. These tabs are associated with a single connection to the Oracle database. This approach makes it easy to rerun prior SQL statements, particularly when testing. This technique is also useful for PL/SQL code such as packages. Putting the package specifications in one tab and the package body in another tab keeps the two separate. The package body won’t compile correctly if any issue exists with the specifications, as shown in Figure 3.3. Dan likes to work with package specifications and the body in separate tabs for this reason. This is a good technique to follow. Toad automatically puts the package spec and body in separate tabs when opening a package either from a file or from the database. This feature is controlled by Toad Options ➔ Editor ➔ Open/Save Packages/Types settings. You can choose this behavior or turn this feature off.
CHAPTER 3 Working with SQL

TIP
You can also initiate multiple logins instead of using multiple tabs. Multiple logins can make moving data/objects between instances of Oracle a snap. Multiple tabs share the same database connection.

The toolbars are easy to configure. Right-click one to see the pop-up menu shown in Figure 3.4.
FIGURE 3.4 Configuring the toolbars

Notice the menu enables you to turn on and off the various toolbars. You can also configure the individual toolbars from here. You can delete unused buttons you find cluttering the toolbars, move buttons around, and add additional buttons. Figure 3.5 shows the toolbar configuration menu. The Toolbars tab enables you to turn toolbars on or off. The Commands tab enables you to add or delete buttons from each particular area of Toad. Drag and drop to move the buttons, remove the buttons, or add additional buttons. The Options tab enables you to turn on or off the mouse hover tips, change the size of the icons, and adjust how Toad stores your executed commands.

FIGURE 3.5 Configuring the toolbar buttons

Notice in Figure 3.4 that you can easily reset these options back to the Toad defaults.

TIP

One of the authors typically closes the Windows menu, and the Team Coding and Connections toolbars to give additional space to the editor windows.
SQL Editor Output Area

The data grid has a tool palette that enables the user to scroll up or down the returned rows, add rows, and delete rows (see Figure 3.6). Notice the light at the cursor along the bottom of the SQL Editor screen (see the cursor position in Figure 3.7). If this is red, then the data in this data grid cannot be changed and the commit/rollback/add/delete rows buttons will be grayed out. If the pseudo column ROWID was selected in the SQL, then this light will be green and the commit/rollback/add/delete rows palette will not be grayed out and the data can be changed.

FIGURE 3.6 Data Tool palette

FIGURE 3.7 Toad data grid

WARNING

Toad only retrieves 500 rows at a time. In Toad11+, moving the scroll bar retrieves the next 500 rows. In older Toad versions, if you move the data scroll bar on the right-hand side, Toad will retrieve all the remaining rows. Be careful!

Many output tabs are available in Toad. These tabs usually automatically display when a request occurs for the data contained to be displayed, such as when you execute the PL/SQL profiler. In that case the Profiler tab should automatically appear. Figure 3.8 shows this list.
FIGURE 3.8 Available output tabs

You can easily display or hide these tabs. Right-click the tab line to see all the tabs available. Simply adjust per your needs. You can also right-click the editor panel and select Desktop from that pop-up menu to get the same list.

The Breakpoints, Call Stack, and Watches tabs are all associated with the PL/SQL Debugger (covered in Chapter 6, “Working with PL/SQL”). The Data Grid tab is associated with any SQL select statement execution. Data grids appear throughout Toad, and the options that are available for this data grid are also available for any data grid. The DBMS Output tab shows any DBMS_OUTPUT.Put_Lin output from a PL/SQL routine. The Explain Plan tab (discussed later this chapter and again in Chapter 10, “Toad as a SQL Tuning Tool”) shows the SQL execution plan; it also has many display options. To populate this tab, click the Explain Plan button. The Messages tab shows any output from the executed SQL, including error messages (its real value). The Navigator tab displays the Navigator panel to the left of the Editor window. The Profiler tab is associated with the PL/SQL Profiler discussed in Chapter 6. The Query Viewer tab shows SQL and PL/SQL that was executed in the SQL window and some interesting statistics such as how long it took to execute. This information is useful for either rerunning that exact same SQL or when doing performance tuning (to easily compare one SQL execution with another). The REF CURSOR Results tab is also associated with PL/SQL execution. The Script Output tab shows character-mode output when the Run as Script button is clicked for execution. Team Coding illustrates others’ participation in coding of particular PL/SQL code and is covered in Chapter 7, “Miscellaneous Tools.” The Trace tab enables SQL statistics and/or SQL Trace files to be generated and displayed for this particular SQL statement. Notice that you can enable both Auto Trace and SQL Trace from this tab (see Figure 3.9). The
Trace tab is discussed in detail in Chapter 10. The remaining items on this menu deal with these tabs themselves—which ones appear when Toad starts up, where they appear—and this includes saving the changes for the next time Toad is started, as well as restoring the default settings from when Toad was originally installed.

FIGURE 3.9 Toad Auto Trace

Clicking the Explain Plan button on the lower-left SQL Editor toolbar shows the Oracle explain plan for the SQL just executed. Right-clicking in this window enables the display to be adjusted.

The Auto Trace tab provides a variety of SQL runtime statistics. You can enable this feature using the check box or right-click in the editor window and select Auto Trace to enable, and then re-execute the SQL to populate the Auto Trace panel. Notice that you can also run a SQL trace on this particular SQL from the SQL Trace sub-tab. This feature needs the ALTER SESSION privilege; SQL trace is covered in detail in Chapter 10. Toad will run the SQL trace and either bring up the output using the TKProf Wizard or the Trace File browser, depending on which feature of Toad you have purchased.

NOTE

The Auto Trace, SQL Trace, and Explain Plan tabs are covered in detail in Chapter 10.
Object Describe

The F4, or Describe Object button, is one of the most versatile features of Toad. Simply put the cursor on a function, table, or other object in the editor window and press the F4 key, and detail about the object appears. The F4 or Describe window is useful for displaying object information and table information including data, syntax, and statistics. You can also access this screen by entering `DESC <object name>` in the SQL Editor.

Figure 3.10 shows a Describe Objects panel. You can call one up by pressing F4 with the cursor on the EMP table in the editor window. Notice the tabs across the center of the screen. Using those tabs you can easily access the other related objects, constraints, statistics, code, privileges, and more.

![Describe Objects panel](image)

**FIGURE 3.10** Describe Objects panel

You can drag and drop column names on the Columns tab onto the SQL window and show other information such as available indexes, constraints, triggers, and so on from this interface as well. This section covers the more important tabs individually.

**TIP**

You can drag and drop columns displayed in the Columns tab into the SQL window—SQL coding without typing!
The location of the Describe Objects panel can be adjusted. Figure 3.11 shows the buttons that control how the panel appears on the screen.

**FIGURE 3.11** EMP Table Describe Objects panel buttons

**NOTE**

Toad 11 and newer put a new tab in this Describe Objects panel for each additional object being described. Older Toads open a new Describe Objects panel for each.

Buttons across the top of this panel (see Figure 3.12) control many items surrounding the object. Use the mouse and hover over any button to display a short description of its function. These buttons include:

- Add objects to this object
- Add to project manager (discussed later in this book)
- Alter/analyze/audit
- Compare
- Create another similar
- Create a script
- Show in various diagrammers
- Generate SQL (generates a select/insert/update/delete and puts it on the clipboard)
- Count/truncate

**FIGURE 3.12** EMP Table Describe Tab buttons
**WARNING**

Toad is not one of those tools in which you should just click the button to see what it does. For example, if you have permissions to delete rows, the Truncate button will delete all the rows! Be careful out there!

The Script tab, shown in Figure 3.13, creates a script that could be saved and used to re-create the object. You can copy this script into a file and use it when creating a test environment for your application. Figure 3.14 shows the options available when you click the Options button on this script panel. Notice the adjustments you can make to the scripts. You can include the data, include drop statements, exclude schema owners (useful when setting up tables/objects for other users), and make other adjustments. Figure 3.15 illustrates the other content that you can include in the script output as well.

**TIP**

The author finds the ability to create scripts from this Scripts tab incredibly useful when creating a test environment for an application change.

---

**FIGURE 3.13**  EMP Table Describe Object panel showing Script tab
CHAPTER 3   Working with SQL

FIGURE 3.14   Script Tab Options panel

FIGURE 3.15   Script Tab Tables Option tab
The Export DDL button (shown in Figure 3.16) enables easy DDL syntax generation. Notice all the options available for optional syntax in the panel in Figure 3.17.
Figure 3.18 shows another data grid but just for the object selected. You can see the same navigation and data control buttons as discussed earlier for the SQL Editor Data Grid tab. Many features are common to all data grids and these are covered in detail in Chapter 5, “Working with Data.”

Be careful with large amounts of data on this panel. Use the Esc key to cancel any long-running data retrieval.

Clicking the Generate Statement button (see Figure 3.19) enables the easy creation of an Insert, Update, or Select statement from the visible columns of this data grid. Make your selection and then paste into the SQL Editor.
Toad Insights

Toad provides easy creation of SQL. The previously mentioned Describe Objects panel enables you to drag and drop columns out of any table object into the SQL Editor. You can also enter the table name (or table alias) with a single period, the table name, another period, and partial leading column spelling, and Toad will pop up a box containing your table object columns and column attributes. Figure 3.20 shows a table with just a single period.

![Toad Insights pop-up panel](image1)

**FIGURE 3.20**  Toad Insights pop-up panel

You can double-click a column in this pop-up window, or multiple select using the mouse and either the Shift (list of items) or Ctrl buttons (specific items in the list) and then press the Enter or Return key to add the items to your code at the current cursor position. Notice in Figure 3.21, three columns were selected, and Toad qualified each with the table name! If you are utilizing table aliases, Toad remembers these and will qualify your code correctly.

![SQL Editor after using Insights](image2)

**FIGURE 3.21**  SQL Editor after using Insights
Notice earlier in Figure 3.20 that the items appearing in the Insights panel are in alphabetical order. One of the authors prefers the order as they appear in the object. Notice the Options button on the Insights panel. You can also access this area via the Configure Toad Options button on the top toolbar.

Figure 3.22 shows the Toad Insights configuration options. Notice that you can define the objects that this feature works on along the top. The center part of this screen allows you to:

- Turn off the feature
- Cache the results (default)
- Display as text
- Sort the list (the author prefers to turn this off)
- Delay the popup (handy for those of us who type slowly...)

You can see some other items (discussed in Chapter 6) such as the Enable parameter assistance (sometimes the author turns this off as it can slow down PL/SQL coding), and some other built-in keystroke assistance.

**Code Snippets**

Toad contains bits of code called code snippets. These snippets contain most of the SQL functions, date formats, hints, and other bits of SQL and PL/SQL code that are of interest to the Oracle developer. Toad configuration options make it possible for additional items to be added or existing items to be changed.
To see the Code Snippets panel choose View ➔ Code Snippets. The panel then appears and auto hides along the right side of Toad (see Figure 3.23). The push pin button can make the panel remain visible on your desktop.

![Code Snippets panel](image)

**FIGURE 3.23** Code Snippets panel

You simply drag and drop the code pieces from this panel to your code.

Figure 3.24 shows the various categories for the snippets. There are snippets for date formatting, various function templates for almost anything, and even SQL Optimizer hints (discussed some in Chapter 10).

![Code Snippets code categories](image)

**FIGURE 3.24** Code Snippets code categories
These snippets are configurable as well. Click the Configure Toad Options button (or access via the menu using View ➔ Toad Options) and visit the Editor ➔ Code Assistant panel as shown in Figure 3.25. This panel enables you to either clean up the categories you will never use, or better yet, add your own custom code snippets that you can easily add to your code via drag and drop.

![Code Snippets](image)

**FIGURE 3.25** Configuring code snippets

### SQL Recall

Toad saves all the work that was done in any of the editor windows.

ALT+Up Arrow and Alt+Down Arrow walk through this storage area. Choose View ➔ SQL Recall or press F8 (see Figure 3.26) to open the interface shown in Figure 3.27.

![SQL Recall Interface](image)

**FIGURE 3.26** Accessing SQL Recall
Notice that the SQL Recall panel shows up as an autohide panel on the left side of Toad. You simply double-click a SQL statement in this panel and Toad will open a new tab and put the SQL in it.

**TIP**

One of the authors uses this SQL Recall during SQL tuning. If a prior SQL statement worked better, then it is easy to find and revisit.

This version of Toad enables the SQL to be moved to the Personal tab or the Named tab. Simply click the Edit Selection button in the SQL Recall window, and then select the Personal or Named option from the Type drop-down menu.

The buttons on the top of this panel (see Figure 3.28) enable you to do the following:

- Save selected SQL to a file
- Copy selected SQL to the clipboard
- Edit the selected SQL (allows for the SQL to be added to the Personal or Named tabs, which makes finding SQL easier, perhaps)
CHAPTER 3   Working with SQL

- Delete from the SQL Recall
- Load into the SQL Editor (Append, New Tab, or Replace into current tab)
- Navigation buttons
- Export/Import all the SQL (useful when updating Toad or moving to a new computer)

FIGURE 3.28   SQL Recall panel buttons

The Configure Toad Option → Editor → Code Assist SQL Recall settings (see Figure 3.29) control how many SQL statements are saved (max is virtually unlimited) and which SQL will be saved (all, or just valid ones). The Save Only Valid Statements option saves only the successful SQL, enabling more SQL to be saved. Typically, programmers are only interested in the SQL statements that didn’t have syntax errors.

FIGURE 3.29   SQL Recall options
Auto Replace

Auto replace is like a spell checker; in fact, this feature actually does correct some spelling errors as well as correct obsolete code. This feature is activated via the space bar. It takes the last item entered since the prior space bar and compares it to a list. If the text is found in the list, the auto replace item is automatically substituted.

This feature is nice for long column names perhaps (although Toad Insights is a better mechanism for this), but it is used more for commonly entered items such as sf for SELECT * FROM or pl for DBMS_OUTPUT.PUTLINE( );.

Chapter 6 discusses a way to use existing code templates and how to add your own.

In an editor window, type in “teh” and when you press the space bar, it will be corrected quickly to “the.” The space bar activates the check. If an item is in the Auto Replace panel, it is substituted.

To remove some auto correct items or to add your own (a good place to add any coding shortcut!), choose View ➔ Toad Options, visit Editor ➔ Behavior, and click the Auto Replace button on the lower-right part of the Behavior panel.

NOTE
Notice all the items that you can control in an editor window from this Behavior panel.

TIP
Dan uses this feature to code his own coding shortcuts.

This button opens the dialog in Figure 3.30. Notice the “teh” in the left side and the “the” in the right column.
To add your own code assistants, click the Add button and fill in the grid as shown in Figure 3.30. One of the authors uses DBMS_OUTPUT.Put_Line frequently, so he wants a pl shortcut for it. Figure 3.31 shows the output when pl is entered and the space bar is tapped.

Query Builder

Toad has a nice Query Builder feature. This feature enables SQL code to be built using mouse operations. This feature is excellent for power users, analysts, and managers using Toad to create reports and access data but who have little knowledge of the SQL language.
The Query Modeler button is on the standard toolbar (the top menu bar, see Figure 3.32). You can also access it via Database ➔ Report ➔ Query Builder, and the button also appears on the ER Diagrammer panel.

The object palette appears on the right (if it doesn't automatically appear, click View ➔ Object Palette). The various items that can be included in a select statement appear on the left. Figure 3.33 shows the canvas with both the EMP table and the DEPT table. These were added using either a double-click operation on each in the object palette or a drag and drop mouse operation from the object palette to the canvas. Notice how Toad built the SQL in the bottom Generated Query tab. As you click on the column names, Query Builder will adjust the SQL! The query can be executed from here, saved, and even moved to a tab in the SQL Editor!

To add WHERE, GROUP BY, HAVING, UNION, and the other clauses, simply double-click the syntax item of interest and use mouse operations to draw in the options you desire. Figure 3.34 shows the Where Conditions clause panel, accessed by double-clicking the Where in the left Query Builder panel (titled Query Browser). Buttons on the toolbar control and bring up these same wizards. You can also build WHERE clauses by simply
dragging a column of interest from the canvas object and drop it on the WHERE clause. This feature works for the other items in the left panel as well. If the operation is a valid request, a wizard will appear to finish the syntax.

Notice in Figure 3.35 that some columns were selected in the EMP and DEPT tables in the canvas and that the syntax was adjusted automatically. Also notice that the SQL syntax is using ANSI joins. Query Builder is an excellent tool for converting from either ANSI SQL to standard Oracle SQL or vice versa! Click the Ansi Join Syntax button, shown by the cursor in Figure 3.35, and you get the SQL in Figure 3.36!
Figure 3.36 shows the Generated Query panel control buttons. The first two buttons enable the generated SQL to be copied to either the editor (a new tab) or to the clipboard. The SQL Optimize button is a purchased feature of Toad (it enables the SQL to be automatically tuned). The Execute Query button will run the SQL from the Query Builder interface and populate the other two tabs present. The Add Table name button enables all the columns to be qualified. The next two buttons make it possible for either an * or the distinct clause to be added to the generated SQL.

![Generated Query Panel control buttons](image)

The Update Diagram and Update SQL can be useful buttons. You can make changes to the SQL via typing or you can paste a SQL statement into this generated SQL area and click the Update Diagram button, and the diagram in the canvas will be updated. Likewise, you can make changes to the diagram in the canvas and click the Update SQL button, and the changes will be made to your generated SQL. The Ansi button is a toggle; it will rewrite your SQL using ANSI join syntax if clicked. The Add Schema Name to Tables and Add Table Names to Column buttons are also toggle buttons. If clicked down, the SQL text will be adjusted accordingly. The final two buttons (Run Query in Threads and Allow Modify Query Results) pertain to how you would like to execute the SQL and possibly have the ability to change results from within the Query Builder environment.

You can add your own subqueries and calculations. There are right-click options under each object on the canvas, different options when right-clicking the object header on the canvas, and others. Calculations are easy to add by either

- Right-clicking the select line on the left Query Builder panel and selecting Add New Expression Column as shown in Figure 3.38.
- Adjusting the text in the Generated Query and clicking the Update Diagram button.
Options for each of the other items appear in this left panel as well. Just right-click and check out the various options. Right-clicking the columns on the canvas enables column aliases to be added. Right-clicking the table name enables an alias to be defined. Remember that a button on the Generated Query panel can add the table name or alias to all the columns in the SQL (a good idea).

There isn’t any SQL that cannot be built using Query Builder. Figure 3.38 shows a calculated column, sal * 1.1, being added to the query.

**FIGURE 3.38** Adding calculations using Query Builder

**Summary**

This chapter covered various aspects of the main SQL Editor window. It is easy to build SQL using the describe function and code snippets. You can enhance Toad for your own coding style using Auto Replace. Toad remembers the SQL that it has worked with. This chapter also covered the Query Builder, a useful tool for those new to Oracle but who have a need to access data within the Oracle RDBMS.
Index

A

About screen, 5
Access file format, saving data in, 106
action code (Automation Designer), 183-187
Action Console, 171
Action toolbar (Editor), 126
Add Schema Name to Tables button (SQL Editor Query Builder), 67
Add Table Names to Column button (SQL Editor Query Builder), 67
Add/Delete Rows buttons (data grids), 104-105
Analyze All Objects screen, 220-222
Ansi button (SQL Editor Query Builder), 67
ANSI SQL, Query Builder (SQL Editor), 66
apps, launching from External Tools, 162
ASH reports, 245-246
Auto Add button (External Tools), 161
Auto Replace panel (SQL Editor), 63-64
Auto Trace tab (SQL Editor Output area), 49-50, 231-232
autocommit feature (data grids), 96
automation, 171
Action Console, 171
Automation Designer, 171, 180
    action code, 183-187
    adding action properties, 188-189
    availability, 188
    Command Line feature versus, 179
    Control tab, 188-190
    functionality, 180-181
    launching, 181
    main screen, 181-183
    programmatic controls, 189
Save/Load Window Snapshot, 180-181
scheduling, 183
toolbar, 182-183
Command Line feature, 171-172
Automation Designer versus, 179
command file example, 173-178
functionality, 172-173
running command files, 178-179
Save/Load settings, 173
shortcomings of, 180
auto-opening windows at startup, 34-36
AWR browser and SQL performance tuning, 245-246

B
Base edition (Toad), 4
BEGIN/END labels (Editor), 126
Bookmark Navigation buttons (data grids), 105
breakpoints (debugging code), 145, 147
  conditional breakpoints, 150-152
  modifying, 149-150
Breakpoints tab (SQL Editor Output area), 49

C
Calculate Selected Cells feature (data grids), 101
calculations, Query Builder (SQL Editor), 67
Call Stack tab (SQL Editor Output area), 49
call stacks, debugging code, 147
Cancel Query Execution or Fetch button (data grids), 104
cells (data grids), Calculate Selected Cells feature, 101
Check tab (Database Health Check), 193
choosing database connections, 27
Clear button (SQL Editor), 45
Code Analysis feature (Editor), 126, 139
  functionality, 139
  Halstead Volume, 142
  Maintainability Index, 142
  McCabe's Cyclomatic Complexity, 142
  Report tab, 139
  Toad Code Rating, 142
  uses of, 139
code folding, 126
Code Road Map, 157-158, 160
  General tab, 159
  Options tab, 159
Code Snippets, 133-134, 231
Code Snippets panel (SQL Editor), 58-60
Code tab (FastReport), 84
code templates, 127
  building, 128-131
  choosing, 127
  Cursor Loop template, 127
  modifying, 127-128
  signaling, 127
  substitution variables, 127
  viewing, 127
color highlighting, Toad/database connections, 13
Command Line feature, 171-172
  Automation Designer versus, 179
  command files
    example of, 173-178
    running, 178-179
  functionality, 172-173
  Save/Load settings, 173
  shortcomings of, 180
Commit/Rollback buttons (data grids), 96, 105
Compare Databases screen, 216-217
Databases tab, 217
Options tab, 217
Results tab, 217
Sync Script tab, 218
Compare Files utility, 163
Compare Schemas screen, 218-219
Options tab, 219
Results tab, 219
Sync Script tab, 219
compiling objects for debugging, 147
conditional breakpoints (debugging code), 150-152
connection errors for bad passwords, 16
Content tab (HTML Documentation Generator), 116
Control tab (Automation Designer), 189-190
copying/pasting in Reports Manager (Schema Browser), 88
Create Table wizard (Schema Browser), 76-78
Cursor Loop template, 127
customizing
Options screen
finding new/unknown options, 37
initial options to focus on, 38-39
pop-ups in options, 39
Toad, 18
keyboard shortcuts, 33-34
menus, 19
Options screen, 19-21, 37-39
Schema Browser, 34-36
sharing options settings, 40
SQL Editor, 34-36
startup options, 36
startup windows/screens, 34-36
toolbars, 19, 30-33
user settings, 40
user settings (Toad), 40

D
Data Grid panel (SQL Editor Describe Objects panel), 56
Data Grid tab (SQL Editor Output area), 49
data grids, 93
autocommit feature, 96
Calculate Selected Cells feature, 101
Cancel Query Execution or Fetch button, 104
capabilities of, 93-95
changing data and permissions, 95-96
commit/rollback buttons, 96
Export Dataset wizard, 102-103
dataset tab, 103
Insert Statements tab, 103
Options tab, 102, 103
saving data, 106-111
filtering/sorting data, 97-99
functionality in, 96-97
Master Detail Browser, 111-113
permissions and changing data, 95-96
pop-up menu, 95
printing via FastReport, 79-80
code tab, 84
Report wizard, 80-83
saving reports, 84
Style tab, 82
Refresh Dataset button, 103
refreshing data, 97
rows
Add/Delete Rows buttons, 104-105
Bookmark Navigation buttons, 105
Edit Row Set Control buttons, 105
Row Set Navigation buttons, 105
saving data
Access file format, 106
Delimited Text file format, 107
Excel File format, 108
Excel Instance format, 108
Fixed Field Spacing option, 108-109
HTML Table file format, 109
Insert Statements file format, 109
Merge Statements file format, 109
ODBC Database file format, 110
SQL Loader option, 111
XML (with XLS) file format, 109
XML file format, 109
Show Detail Dataset button, 100
Show/Hide Columns menu, 100
Single Record Viewer button, 105
sorting
columns, 97
data, 97-99
SQL Editor, 95
View/Edit Query panel, 99
Data Pump Export wizard, 205-209
data tool palette (SQL Editor Output area), 48
database administration, 191
Analyze All Objects screen, 220-222
Compare Databases screen, 216-217
Databases tab, 217
Options tab, 217
Results tab, 217
Sync Script tab, 218
Compare Schemas screen, 218-219
Options tab, 219
Results tab, 219
Sync Script tab, 219
Data Pump Export wizard, 205-209
Database Browser, 197-202
Datafile IO tab, 200
Sessions tab, 199
Space Usage tab, 200-201
tablespace management, 210-212
Database Health Check, 192-193
Check tab, 193
Diffs Since Last Run tab, 194
Parameter screen, 193
Report Output tab, 194
Schemas tab, 194
Settings tab, 194
DB Admin Module, 4, 191-192, 224-226
Export Utility wizard
Data Pump Export wizard, 205-209
Generate Database Script screen, 212-214
Generate Schema Script screen, 214-215
simple exports, 202-204
Generate Database Script screen (Export Utility wizard), 212
Object Listing tab, 214
Object Types tab, 213
Script Options tab, 213
Source and Output tab, 212-213
Generate Schema Script screen (Export Utility wizard), 214
Object Types tab, 215
Script Options tab, 215
Source and Output tab, 215
SQL display, 215
Rebuild Multiple Objects screen, 223
Storage Clause Adjustments tab, 224
Thresholds and Performance Options tab, 223
Session Browser, 194-196
Locks tab, 196
tracing/killing sessions, 196
Waits tab, 197
tablespace management, 210-212
Database Browser, 197-202
Datafile IO tab, 200
Sessions tab, 199
Delimited Text file format, saving data in, 107
Describe Objects panel (SQL Editor), 51
  changing panel location, 52
Data Grid panel, 56
  dragging/dropping columns, 51
EMP Table Describe Panel buttons, 52
Export DDL panel, 55
Generate Statement panel, 56
Script tab, 53
  viewing button functionality, 52-53
development of Toad, 2-3
  editions/suites, 3-5
Oracle compatibility, 3
diagramming objects via Code Road Map,
  157-158, 160
  General tab, 159
  Options tab, 159
Diffs Since Last Run tab (Database Health
  Check), 194
  dragging/dropping columns in Describe Objects
panel (SQL Editor), 51

E

Edit Row Set Control buttons (data grids), 105
  editing
    objects in Schema Browser, 76
    reports in Reports Manager (Schema
    Browser), 88
  View/Edit Query panel (data grids), 99
Editor, 121
  Action toolbar, 126
  autohiding output tabs, 124
  BEGIN/END labels, 126
  Code Analysis feature, 126, 139
    functionality, 139
    Halstead Volume, 142
  Maintainability Index, 142
  McCabe's Cyclomatic Complexity, 142
  Report tab, 139
  Toad Code Rating, 142
  uses of, 139
code folding, 126
code templates, modifying, 127-128
debugging code, 123-124
Execute PL/SQL button, 123-124, 146-147
Execute/Compile button, 123
  formatting code, 127
  full screen mode, 124
  highlighting code, 126
  IF/END IF labels, 126
  keyboard shortcuts, 135-137
  Load Database Object wizard, 122-123
  opening files in, 122
  saving code, 123
  Schema Browser, loading files from, 123
Editor button (SQL Editor), 44
EMP Table Describe Panel buttons, Describe
  Objects panel (SQL Editor), 52
ER Diagrammer, 113-114
Excel File format, saving data in, 108
Excel Instance format, saving data in, 108
Execute PL/SQL button (Editor), 123-124,
  146-147
Execute/Compile button (Editor), 123
  execution plans and SQL performance tuning,
  229-231
Explain Plan tab (SQL Editor Output area),
  49, 50
  explain plans (SQL performance tuning),
  227-229
    code snippets, 231
    execution plans, 229-231
Export Dataset wizard (data grids), 102-103
  Dataset tab, 103
  Insert Statements tab, 103
Options tab, 102-103
saving data, 106
  Access file format, 106
  Delimited Text file format, 107
  Excel File format, 108
  Excel Instance format, 108
  Fixed Field Spacing option, 108-109
  HTML Table file format, 109
  Insert Statements file format, 109
  Merge Statements file format, 109
  ODBC Database file format, 110
  SQL Loader option, 111
  XML (with XLS) file format, 109
  XML file format, 109
Export DDL panel (SQL Editor Describe Objects panel), 55
Export Utility wizard
  Data Pump Export wizard, 205-209
  Generate Database Script screen, 212
  simple exports, 202-204
External Tools program launcher, 160
  Auto Add button, 161
  configuration screen, 161
  launching apps from, 162
  Manual Add button, 162

FastReport data printing, 79-80
  Code tab, 84
  Report wizard, 80-83
  saving reports, 84
  Style tab, 82
Favorites list (Schema Browser), 73-74
filtering
  data grid data, 97-99
  database connections, 28
  objects, Schema Browser, 72
Fixed Field Spacing option, saving data in, 108-109
folding code in Editor, 126
formatting code in Editor, 127
full screen mode (Editor), 124

G
General tab (Code Road Map), 159
Generate Database Script screen (Export Utility wizard), 212-213
  Object Listing tab, 214
  Object Types tab, 213
  Script Options tab, 213
  Source and Output tab, 212-213
Generate Schema Script screen (Export Utility wizard), 214
  Object Types tab, 215
  Script Options tab, 215
  Source and Output tab, 215
  SQL display, 215
Generate Statement panel (SQL Editor Describe Objects panel), 56
Generated Query panel (SQL Editor Query Builder), 66-67
grouping database connections, 29-30

H
Halstead Volume (Code Analysis reports), 142
Halt button (SQL Editor), 45
Health Check, 192-193
  Check tab, 193
  Diffs Since Last Run tab, 194
  Parameter screen, 193
  Report Output tab, 194
  Schemas tab, 194
  Settings tab, 194
  hiding/displaying
    output tabs in Editor, 124
    Show/Hide Columns menu (data grids), 100
    tabs in Output area (SQL Editor), 48-49
  highlighting
    code in Editor, 126
    Toad/database connections, 13
  HTML Documentation Generator, 115-118
    Content tab, 116
    HTML output and, 118
    Object Descriptions tab, 117
    Summary.html files, 116
    installer files, 6
    Windows prerequisites, 5-6
  HTML Table file format, saving data in, 109

IF/END IF labels (Editor), 126
  Insert Statements file format, saving data in, 109
  Insert Statements tab
    (Export Dataset Wizard), 103
  Insights panel (SQL Editor), 57-58
  installing Toad, 6-8

J
  JIT (Just-In-Time) debugging, 152-153

K
  keyboard shortcuts
    debugging code, 143
    Editor, 135-137
    Toad shortcuts, 33-34
  killing/tracing sessions (Session Browser), 196

L
  launching programs. See External Tools
  licensing Toad, installer license screen, 7
  Load Database Object wizard, 122-123
  Locks tab (Session Browser), 196
  logins (multiple) in SQL Editor, 46
  Looping_Example
    debugging code, 143, 144, 147
    profiling code, 154-156

M
  Maintainability Index (Code Analysis reports), 142
  Manual Add button (External Tools), 162
  Master Detail Browser, 111-113
  McCabe’s Cyclomatic Complexity (Code Analysis reports), 142
Menu bar, debugging code options, 144
menus, customizing, 19
Merge Statements file format, saving data in, 109
Messages tab (SQL Editor Output area), 49

N
naming reports, Reports Manager (Schema Browser), 87
Navigator tab (SQL Editor Output area), 49
No Oracle Net Services error, 9

O
Object Descriptions tab (HTML Documentation Generator), 117
Object Listing tab (Generate Database Script screen), 214
Object Palette, ER Diagrammer and, 113-114
Object Types tab
  Generate Database Script screen, 213
  Generate Schema Script screen, 215
objects
Analyze All Objects screen, 220-222
compiling objects for debugging, 147
Describe Objects panel (SQL Editor), 51
  changing panel location, 52
Data Grid panel, 56
  dragging/dropping columns, 51
EMP Table Describe Panel buttons, 52
Export DDL panel, 55
Generate Statement panel, 56
Script tab, 53
  viewing button functionality, 52-53
diagramming via Code Road Map, 157-158, 160
  General tab, 159
  Options tab, 159
ER Diagrammer, 113-114
Rebuild Multiple Objects screen, 223
  Storage Clause Adjustments tab, 224
  Thresholds and Performance Options tab, 223
Schema Browser
  adding objects, 73
  configuring object display, 70-72
  control buttons, 75
Create Table wizard, 76-78
  creating objects, 76-78
  displaying objects, 70-72
  editing objects, 76-78
  enabling objects, 73
Favorites list, 73-74
filtering objects, 72
grouping objects, 73
maintaining objects, 73
scheduling object creation, 78
selecting objects, 73
Show SQL button, 78
ODBC Database file format, saving data in, 110
Options screen, Toad customization, 19-21
  finding new/unknown options, 37
  initial options to focus on, 38-39
  pop-ups in options, 39
Options tab
  Analyze All Objects screen, 221-222
Code Road Map, 159
Compare Databases screen, 217
Compare Schemas screen, 219
Export Dataset Wizard, 102-103
Oracle

Oracle Net Services
No Oracle Net Services error, 9
Toad connections (first time), 9-10
sending SQL statements to, 44
Toad compatibility, 3
Oracle Homes, Toad operation (first time), 14-15
Oracle SQL, Query Builder (SQL Editor), 66
organizing
database connections, 25
choosing, 27
filtering, 28
grouping, 29-30
sorting, 26
objects via Project Manager, 132
adding objects to project folders, 132
creating project folders, 133
interface of Project Manager, 132
maintaining Project Manager via Schema Browser, 132
toolbar, 133
Output area (SQL Editor)
Auto Trace tab, 49-50, 231-232
Breakpoints tab, 49
Call Stack tab, 49
Data Grid tab, 49
DBMS Output tab, 49
Explain Plan tab, 49, 50
hiding/displaying tabs, 48-49
Messages tab, 49
Navigator tab, 49
Output area, data tool palette, 48
Profiler tab, 48-49
Query Viewer tab, 49
REF CURSOR Results tab, 49
Script Output tab, 49
SQL Trace tab, 49-50, 233-238
Trace tab, 49-50
Watches tab, 49

P

Parameter screen (Database Health Check), 193
password connection errors, Toad/database connections, 16
performance
SQL performance tuning, 227, 249-250
AWR browser, 245-246
explain plans, 227-231
PL/SQL Profiler, 246-248
SQL Optimizer, 248-249
SQL Trace tab (SQL Editor Output area), 233-242
statistics, 231-232
Statspack browser, 243-245
TKProf wizard, 238-241, 242
Trace File Browser, 241-242
Toad performance, common questions, 22
permissions, data grids, 95, 96
PL/SQL
code snippets, 133-134
code templates, 127
building, 128-131
choosing, 127
cursor Loop template, 127
modifying, 127-128
signaling, 127
substitution variables, 127
viewing, 127
debugging code, 123-124, 142
advanced debugging, 148-153
basic debugging, 142-148
Editor
   Action toolbar, 126
   autohiding output tabs, 124
   BEGIN/END labels, 126
   Code Analysis feature, 126, 139-142
code folding, 126
   debugging code, 123-124
   Execute PL/SQL button, 123-124, 146-147
   Execute/Compile button, 123
   formatting code, 127
   full screen mode, 124
   highlighting code, 126
   IF/END IF labels, 126
   keyboard shortcuts, 135-137
   Load Database Object wizard, 122-123
   modifying code templates, 127-128
   opening files in, 122
   saving code, 123
   formatting code, 127
   profiling, 153-156
   saving code, 123
   Schema Browser, loading files from, 123
   PL/SQL Profiler and SQL performance tuning, 246-248
   printing FastReport, 79-80
   Code tab, 84
   Report wizard, 80-83
   saving reports, 84
   Style tab, 82
   Professional edition (Toad), 4
   Profiler tab (SQL Editor Output area), 48-49
   profiling PL/SQL, 153-156
   program launchers. See External Tools
   Project Manager, 132
      interface of, 132
      maintaining via Schema Browser, 132
   Refresh Dataset button (data grids), 103
   refreshing data in data grids, 97

   project folders
   adding objects to, 132
   creating project folders, 133
toolbar, 133

   Q
   queries
      Cancel Query Execution or Fetch button, 104
      View/Edit Query panel (data grids), 99
   Query Builder (SQL Editor), 64-65
      Add Schema Name to Tables button, 67
      Add Table Names to Column button, 67
      Ansi button, 67
      ANSI SQL, 66
      calculations, 67
      Generated Query panel, 66-67
      Oracle SQL, 66
      subqueries, 67
      Update Diagram button, 67
      Update SQL button, 67
      WHERE clauses, 66
   Query Viewer tab (SQL Editor Output area), 49
   Quick Scripts, 167

   R
   Rebuild Multiple Objects screen, 223
      Storage Clause Adjustments tab, 224
      Thresholds and Performance Options tab, 223
   REF CURSOR Results tab (SQL Editor Output area), 49
   Refresh Dataset button (data grids), 103
   refreshing data in data grids, 97
release history of Toad, 2-3
  editions/suites, 3-5
  Oracle compatibility, 3
Report Output tab (Database Health Check), 194
Report tab (Code Analysis feature), 139
Report wizard (FastReport), 80-83
Reports Manager (Schema Browser)
  adding reports to, 85-90
  adding scripts to, 90
  copying/pasting in, 88
  editing reports, 88
  naming reports, 87
  running reports, 90
  toolbar buttons, 86
Results tab
  Compare Databases screen, 217
  Compare Schemas screen, 219
Rollback/Commit buttons (data grids), 96, 105
Row Set Navigation buttons (data grids), 105
rows (data grids)
  Add/Delete Rows buttons, 104-105
  Bookmark Navigation buttons, 105
  Edit Row Set Control buttons, 105
  Row Set Navigation buttons, 105
Run to Cursor feature (Debugger), 143
running Toad (first time)
database connections, 10-16
  color highlighting, 13
  connection errors for bad passwords, 16
  Oracle Homes, 14-15
  TNS tab, 10-11
  TNSNAMES Editor, 11-13
No Oracle Net Services error, 9
Oracle Net Services connections, 9-10
Schema Browser, 17-18
SQL Editor, 16
Windows bit compatibility, 10

S
Save/Load Window Snapshot (Automation Designer), 180-181
saved database connection grid (Toad)
  choosing connections, 27
  filtering connections, 28
  grouping connections, 29-30
  sorting connections, 26
saving
  code in Editor, 123
data
  Access file format, 106
  Delimited Text file format, 107
  Excel File format, 108
  Excel Instance format, 108
  Export Dataset wizard (data grids), 106-111
  Fixed Field Spacing option, 108-109
  HTML Table file format, 109
  Insert Statements file format, 109
  Merge Statements file format, 109
  ODBC Database file format, 110
  SQL Loader option, 111
  XML (with XLS) file format, 109
  XML file format, 109
  PL/SQL code in Editor, 123
reports, FastReport data printing, 84
scheduling
  Automation Designer, 183
object creation in Schema Browser, 78
Schema Browser, 17-18, 69
  adding objects, 73
  auto-opening at startup, 34-36
  configuring, 70-72
  control buttons, 75
  Create Table wizard, 76-78
creating objects, 76-78
Show SQL button (Schema Browser)  263

scripts
  Generate Database Script screen (Export Utility wizard), 212
    Object Listing tab, 214
    Object Types tab, 213
    Script Options tab, 213
    Source and Output tab, 212-213
  Generate Schema Script screen (Export Utility wizard), 214
    Object Types tab, 215
    Script Options tab, 215
    Source and Output tab, 215
    SQL display, 215
  Reports Manager (Schema Browser), adding scripts to, 90
  Sync Script tab
    Compare Databases screen, 218
    Compare Schemas screen, 219

security (database), common questions, 22

sending SQL statements to Oracle, 44

Session Browser, 194-196
  Locks tab, 196
  tracing/killing sessions, 196
  Waits tab, 197

Sessions tab (Database Browser), 199

Sharing tab (Database Health Check), 194

sharing
  Toad options settings, 22, 40
  user settings (Toad), 40

shortcuts
  keyboard shortcuts
    debugging code, 143
    Editor, 135-137
    Toad shortcuts, 33-34

  SQL coding, Auto Replace panel (SQL Editor), 63-64

Show Detail Dataset button (data grids), 100

Show SQL button (Schema Browser), 78
Show/Hide Columns menu (data grids), 100
Single Record Viewer button (data grids), 105
snapshot (.DEF) files, 213
snippets (code). See Code Snippets panel (SQL Editor)
sorting
data grids
columns, 97
data, 97-99
database connections, 26
Source and Output tab
Generate Database Script screen, 212-213
Generate Schema Script screen, 215
Space Usage tab (Database Browser), 200-201
spellchecking, Auto Replace panel (SQL Editor), 63-64
SQL
ANSI SQL, Query Builder (SQL Editor), 66
code snippets, 133-134
formatting code, 127
Oracle SQL, Query Builder (SQL Editor), 66
performance tuning, 227, 249-250
AWR browser, 245-246
explain plans, 227-231
PL/SQL Profiler, 246-248
SQL Optimizer, 248-249
SQL Trace tab (SQL Editor Output area), 233-238
statistics, 231-232
Statspack browser, 243-245
TKProf wizard, 238-241, 242
Trace File Browser, 241-242
shortcuts, coding in Auto Replace panel (SQL Editor), 63-64
SQL Editor, 16, 43
Auto Replace panel, 63-64
auto-opening at startup, 34-36
button descriptions, viewing, 44
Clear button, 45
Code Snippets panel, 58-60
data grids, 95
data tool palette (Output area), 48
Describe Objects panel, 51
changing panel location, 52
Data Grid panel, 56
dragging/dropping columns, 51
EMP Table Describe Panel buttons, 52
Export DDL panel, 55
Generate Statement panel, 56
Script tab, 53
viewing button functionality, 52-53
Editor button, 44
functionality, 45
Halt button, 45
input options, 45
Insights panel, 57-58
multiple logins, 46
Output area
Auto Trace tab, 49-50, 231-232
Breakpoints tab, 49
Call Stack tab, 49
Data Grid tab, 49
data tool palette, 48
DBMS Output tab, 49
Explain Plan tab, 49, 50
hiding/displaying tabs, 48-49
Messages tab, 49
Navigator tab, 49
Profiler tab, 48, 49
Query Viewer tab, 49
REF CURSOR Results tab, 49
Script Output tab, 49
SQL Trace tab, 49-50, 233-238
Trace tab, 49-50
Watches tab, 49
Query Builder, 64-65
  Add Schema Name to Tables button, 67
  Add Table Names to Column button, 67
  Ansi button, 67
  ANSI SQL, 66
  calculations, 67
  Generated Query panel, 66-67
  Oracle SQL, 66
  subqueries, 67
  Update Diagram button, 67
  Update SQL button, 67
  WHERE clauses, 66
sending statements to Oracle, 44
SQL Recall panel, 60-62
toolbars
  configuring, 46-47
  resetting options, 47
  standard toolbar, 45
SQL Loader option, saving data in, 111
SQL Optimizer and SQL performance tuning, 248-249
SQL Recall panel (SQL Editor), 60-62
SQL Trace tab (SQL Editor Output area), 49-50, 233-238
startup options (Toad), customizing, 36
startup windows/screens (Toad), customizing, 34-36
statements
  Generate Statement panel (SQL Editor Describe Objects panel), 56
  Insert Statements file format, saving data in, 109
  Insert Statements tab (Export Dataset Wizard), 103
  Merge Statements file format, saving data in, 109
Statspack browser and SQL performance tuning, 243-245
Step Into button (debugging code), 145
stopping code during debugging, 143
Storage Clause Adjustments tab (Rebuild Multiple Objects screen), 224
Style tab (FastReport), 82
subqueries, Query Builder (SQL Editor), 67
suites (Toad), 4-5
Summary.html files (HTML Documentation Generator), 116
symbolic debugging, 142
  advanced debugging, 148-153
  basic debugging, 142-148
Sync Script tab
  Compare Databases screen, 218
  Compare Schemas screen, 219
T

Tables tab (Schema Browser), 75
tablespace management, 210-212
templates (code), 127
  building, 128-131
  choosing, 127
  Cursor Loop template, 127
  modifying, 127-128
  signaling, 127
  substitution variables, 127
  viewing, 127
Terminate Execution button (debugging code), 144
testing data, Show Detail Dataset button, 100
Thresholds and Performance Options tab (Rebuild Multiple Objects screen), 223
TKProf wizard and SQL performance tuning, 238-241, 242
TNS tab, Toad/database connections, 10-11
TNSNAMES Editor, 11-13, 164
Toad
About screen, 5
Base edition, 4
common questions, 21
  database security, 22
  functionality, 21-22
  performance, 22
  sharing options settings, 22
connection screen, 10
customizing, 18
  keyboard shortcuts, 33-34
  menus, 19
  Options screen, 19-21, 37-39
  Schema Browser, 34-36
  sharing options settings, 40
  SQL Editor, 34-36
  startup options, 36
  startup windows/screens, 34-36
toolbars, 19, 30-33
  user settings, 40
database connections, 10
  choosing, 27
  color highlighting, 13
  connection errors for bad passwords, 16
  filtering, 28
  grouping, 29-30
  Oracle Homes, 14-15
  organizing, 25-30
  sorting, 26
  TNS tab, 10-11
  TNSNAMES Editor, 11-13
database security, common questions, 22
DB Admin Module, 4
.DEF files, 213
functionality, common questions, 21-22
installing, 6-8
  installer files, 6
  installer license screen, 7
  Windows prerequisites, 5-6
licensing, installer license screen, 7
Options screen
  finding new/unknown options, 37
  initial options to focus on, 38-39
  pop-ups in options, 39
Oracle Homes, 14-15
Oracle Net Services connections, 9-10
  performance, common questions, 22
  prerequisites, 5-6
Professional edition, 4
release history, 2-3
  editions/suites, 3-5
  Oracle compatibility, 3
running (first time)
  connection screen, 10
  database connections, 10-16
  No Oracle Net Services error, 9
  Oracle Net Services connections, 9-10
  Schema Browser, 17-18
  SQL Editor, 16
  Windows bit compatibility, 10
saved database connection grid
  choosing connections, 27
  filtering connections, 28
  grouping connections, 29-30
  sorting connections, 26
Schema Browser, 17-18, 34-36
sharing options settings, common questions, 22
SQL Editor, 16, 34-36
  suites, 4-5
Windows prerequisites, 5-6
Xpert edition, 4
Toad Code Rating (Code Analysis reports), 142
Toggle PL/SQL Profiling button (PL/SQL profiling), 153

toolbars
  Action toolbar (Editor), 126
  Automation Designer, 182-183
  customizing, 19, 30
    displayed toolbars, 30
    toolbar layouts, 31-33
  debugging code toolbar, 143
  Project Manager, 133
  Reports Manager (Schema Browser), 86
  Script Manager, 166-167
  SQL Editor
    configuring, 46-47
    resetting options, 47
    standard toolbar, 45
Trace File Browser and SQL performance tuning, 241-242
Trace tab (SQL Editor Output area), 49-50
tracing/killing sessions (Session Browser), 196
tree view (Schema Browser), 70-72
trigger code, debugging, 152
tuning SQL performance, 227, 249-250
  AWR browser, 245-246
  explain plans, 227-229
  code snippets, 231
    execution plans, 229-231
  PL/SQL Profiler, 246-248
  SQL Optimizer, 248-249
  SQL Trace tab (SQL Editor Output area), 233-238
  statistics, 231-232
  Statspack browser, 243-245
  TKProf wizard, 238-241, 242
  Trace File Browser, 241-242

U
UNIX Monitor, 167-168
Update Diagram button (SQL Editor Query Builder), 67
Update SQL button (SQL Editor Query Builder), 67
user settings (Toad), sharing, 40

V
View/Edit Query panel (data grids), 99

W
Waits tab (Session Browser), 197
watches (debugging code), 145, 147, 148
Watches tab (SQL Editor Output area), 49
WHERE clauses, Query Builder (SQL Editor), 66
Windows (Microsoft)
  bit compatibility and Toad operation, 10
  Toad prerequisites, 5-6
wizards
  Create Table wizard (Schema Browser), 76-78
  Data Pump Export wizard, 205-209
  Export Dataset wizard (data grids), 102-103
    Dataset tab, 103
    Insert Statements tab, 103
    Options tab, 102-103
    saving data, 106-111
  Export Utility wizard
    Data Pump Export wizard, 205-209
    Generate Database Script screen, 212-214
268 wizards

Generate Schema Script screen, 214-215
simple exports, 202-204
Load Database Object wizard, 122-123
Report wizard (FastReport), 80-83
TKProf wizard and SQL performance tuning, 238-241, 242

X - Y - Z

XML (with XLS) file format, saving data in, 108
XML file format, saving data in, 108
Xpert edition (Toad), 4